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PREFACE 

 

 

Use this manual for both the US and International English editions of The Stanford Bank Game (SBG). The 

underlying processing program/model for both editions is identical; selected terms will differ in the reports 

and students manual.  

 

Appendix A provides a listing of the differences in terminology. When terms that are different for the US 

and International versions are used, the US version terminology is shown first, followed by the International 

English terminology in parenthesis in italics: for example, Federal Funds (LIBOR Funds). 

 

We encourage your input, suggestions, or ideas. 

 

Version 12 is a major departure from earlier editions of SBG as the new spreadsheet file allows instructors 

to do more with SBG.  We hope all clients will be generous in sharing material that employ this feature and 

be willing to make such material available to other users of the game. 

 

The website for SBG is www.hrwinc.com.  Please include “SBG” in the header of your e-mail to 

bankgame@hrwinc.com. 
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INTRODUCTION 

 

 

The Stanford Bank Game (formerly known as the Stanford Bank Management Simulator or SBMS) is a 

Microsoft® Windows™ program that runs on a personal computer. It simulates the operations of a 

commercial bank, based on the decisions of management teams. The program is designed to be used as a 

training device to give current and future managers of financial institutions a working knowledge of the 

financial interrelationships within a commercial bank. Participants make short-term operating decisions 

while at the same time considering the implications of these decisions for long-term growth and 

profitability. Although the relationships in the program are idealized and do not necessarily reflect the 

particular operations of any actual bank or class of banks, participants work with a fairly complex and 

realistic model and are challenged to make optimal decisions within this framework. 

The basic operational unit of the game is the individual bank. The basic time unit is the calendar 

quarter. No seasonal patterns exist. In each quarter of the game, SBG computes the earnings and operating 

results for each bank by processing the decisions of the participating banks, the financial positions of the 

banks at the start of the quarter, and the economic data specifying the operating environment.  

At the end of each quarter, the program generates several reports: the Instructor’s Report, which 

summarizes the performance of each bank, and individual reports for each bank, which give that particular 

bank’s financial position and the composition of its loan and investment portfolios as well as comparative 

information on all banks. Version 12 provides instructors with the option of creating a CSV file of the 

student decision (same data as in the PDF output report) that can easily be copied into a spreadsheet. The 

ending financial position of each bank in one quarter becomes that bank’s starting financial position in the 

following period.  

COMPONENTS OF THE STANFORD BANK GAME 
The Stanford Bank Game is a self-contained package which consists of the following items that can be 

downloaded from the web site <www.hrwinc.com>. 

 

1. Students Manual:  This manual contains the information a participant needs to understand the 

operating environment of the simulation, to make the input decisions, and to interpret the output 

reports. Ratios or terms used in the simulation are defined in the manual. 

2. Instructor’s Manual:  This manual contains information about the Instructor’s Report and the 

operations of the simulation.      

3. Program Model.  The download is an installer with a trail/test version of SBG.     

4.    Supplemental student materials.   

THE OPENING POSITION 
The game begins for initial input with year 2, quarter 2 (2.2). In the reports for quarter 1.4 and 2.1 in the 

Students Manual and period 2.1 in the Instructor’s Manual, Bank 1 represents the actual position of all of 

the banks at the beginning of the game. By studying the changes that have occurred from period 1.4 to 2.1, 

students can begin to learn how the game works even before their first decision must be made.  

  

http://www.hrwinc.com/


 THE INSTRUCTOR’S MANUAL 

INSTRUCTOR’S REPORT 
Each quarter, SBG prints reports to help the instructor assess the performance of the individual banks. The 

Instructor’s Report summarizes key factors that are useful in evaluating the performance of the individual 

bank teams. (See examples and definitions in Appendices B and C).  

INSTRUCTOR OPTIONS 
The instructor may operate Version 12 in one of two ways: 

1. The Partially Competitive Option: Under this option, the banks compete only against the 

environment. The decisions of any one bank playing the game do not influence the results of the other 

banks. 

2. The Completely Competitive Option: With this option, the banks compete both against the 

environment and against each other. The competing banks are assigned to sets of banks, called 

communities.  

The competitive mode does not use a zero sum approach. In the competitive mode, the computer 

program first allocates loans and deposits based on the various interest rates offered or charged by the banks 

compared to “All Banks in the Economy.” If the banks in the competitive community have substantive 

differences in their decision data, the model may adjust the loan and deposit allocations accordingly. In the 

competitive mode, a bank cannot lose more than 10% of the business it would have acquired in the non-

competitive mode. Under certain circumstances, a bank may acquire a significant amount of additional 

business by taking a small percentage from all of the other banks. Generally, the competitive mode has only 

limited impact on the results of the game.  

Most instructors use the partially competitive option for the first two or three quarters and then switch 

to the completely competitive mode when the participants are more familiar with the game. In any case, the 

instructor should tell the participants which option is being used. 

Competitive Communities 
You can run a maximum of eight banks in a single game, but only seven banks in a single competitive 

community. If you have nine or more teams, you will need to divide the teams into two separate games. 

If you want to have a single winning team in a game with more than seven banks (the maximum in a 

single competitive community), you should run the program in the non-competitive mode for all groups. 

Remember, the teams in a community compete only against the other banks in their community and the 

environment. It is not entirely fair to compare the results between two competitive communities, because in 

the competitive mode a bad decision by one or two banks can create positive results for other banks in that 

community, but not in the other. If you want participants to compare or review the results in another game, 

distribute copies of pages 8, 9, and 10 from the other program.  

If you do not need to have a single winning team, you can divide the teams into separate competitive 

communities, thereby reducing the amount of competitive data each team needs to analyze. In a single 

game, you can have two competitive communities, as long as each community has the same number of 

banks. If you have eight teams, you can divide the teams into two separate competitive communities of four 

banks each. 

 

If you run a game with five or six banks in a community, the participants receive the optimum amount 

of data: enough to make their analysis meaningful, but not too much to be overwhelming. If you run a game 
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with less than four teams in a community, the participants may not have enough information to evaluate the 

computer data properly.  SBG ships with two test games.  If you only have enough students for one or two 

groups you can just overwrite the decisions in one of the test games and your students will have information 

on other banks. 

Economic Data 
At the heart of the model are parameters defining specific economic conditions during each quarter of 

simulation. Eight economic scenarios are included. You can play ten quarters—through period 4.4.  

Economies 1, 2, 3 & 4 are simplified.  Economies 5, 6, 7 & 8 are variations on the first 4 but are more 

realistic and less predictable.  They should be used with more advanced students. Economies 1, 2, 5 & 6 are 

low inflation.  Economies 3, 4, 7 & 8 have slightly higher inflation rates. 

 

 
RUNNING THE STANFORD BANK GAME  

One unique aspect to the SBG software is that the only data that is saved is the student decision 

information.  Every time you start a new game a new “decis **.sbg” file is created in the “bankgame” 

folder.  There is a file called “gameini.sbg” that holds the general game setup information.  You can open 

this file with any text reader like Notepad and you can see all of the information such as the bank names for 

any game you have.  This information can be edited if the need arises.  If you need to know which decision 

file is associated with a particular game just open the gameini.sbg.  Data 01 corresponds with the 

decis01.sbg.   

Every time you run a cycle with the SBG software all previous cycles are redone. So, there is seldom a 

need to save decision files as they are very easy to recreate.   

Still a potential downside to this approach is that any modification to the decisions and to internal 

equations in SBG, when a game is in progress, changes data in earlier student reports.   

HARDWARE AND SOFTWARE REQUIREMENTS 

You should be able to run SBG on any current Windows operating system. SBG 12 is a 32 bit program.  

 

INSTALLING THE PROGRAM  
In today’s security conscience environment almost all PC’s that are not personally owned by an 

individual have features to protect the operating system.  Even individually owned PC’s if configured for a 

network may have protection.  You must have full administrative access to the PC in order to install the 

SBG program.  If you do not then you should have technically support do the install. Almost all of the 

issues we have encountered in the past few years with users installing the game have been related to 

security.  

If you download the installer from the web site it installs  a trial/test version.  The game will run quarter  

2.2 – it is not functional beyond 2.3.  When you become an authorized  user of SBG, we will e-mail you a 

fully functioning version.. 

 It is a good idea to have tech support download the install SBG as some networks have security 

that prevent downloads.  Running the setup.exe installs the program.  You cannot copy the SBG program 

from one computer to another, you must run an install.  Our install program contains a few Microsoft 

files that must be in the Windows system directory in order to run the SBG software. 

When the installation is complete, you are returned to Windows. The Stanford Bank Game icon in a 

Stanford Bank Game program group appears. You can now start the program by choosing the Stanford 

Bank Game icon. 



Once you become an authorized user and have received the fully functioning EXE from HRW,  

rename or delete the Trial/Test EXE; then load the new EXE we have sent you. 

Before using SBG we suggest you create a subfolder “Originals” and place copies of the gameini.sbg 

,decis99.sbg, and decis98.sbg in the SBG program folder,  This allows you to easily go back to the original 

install position.  We also suggest you create subfolder for your game files. SBG 12 generates a large 

number of files for the CSV (comma separated values) features. 

STARTING THE PROGRAM 

To start the program 

1) Your PC and Windows Open 

2) Choose the Stanford Bank Game icon. The Stanford Bank Game main window appears. 

  

 

Stanford Bank Game Main Window 

The main window displays the following information: 

Course 

Information 

The name of the professor, the assistant, and the course, and the scheduled time for the 

selected game. You enter this information in the Options window when you start a new 

game.  

Selected Game The names of the bank games. You choose a name when you start a new game. 
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Period The current period for the selected game. You can change the period by placing the cusor in 

this window and pressing the “+” or “-“ keys  

STARTING A NEW GAME  
When you start a new game, you enter three sets of options: Course Identification, Bank Names, and Game 

Options. Before you run the first cycle of the game, you must also set the Print options. 

To start a new game 

1) Start the Stanford Bank Game as explained earlier, if it is not already running. 

2) From the File menu, choose New Game. The Options window appears with the Course 
Identification tab on top. 

 

Course Identification Tab, Options Window 

To enter the Course Identification 

1) Enter the following information in the text boxes: 

 Professor 

 Assistant 

 Course 

 Scheduled 



 Game 

 You can change this name if you want by typing directly in the text box. 

 Use the mouse or the TAB key to move between the text boxes. 

2) Enter the Bank Names as explained next. 

To enter the Bank Names 

1) In the Options window, choose the Bank Names tab. 

  

 Bank Names Tab, Options Window 

 The Bank Names tab shows the name, number, and number of players for each bank. 

2) Enter the following information in the text boxes:  

Banks After each bank number, enter a name for the bank. The number of bank names 

that you enter sets the number of banks in the game. 

Players After each bank number and name, enter the number of players for that bank. 

The number of players is used to determine the number of copies of the reports 

to print.  It is usually easier to use a copier to make more than one copy. 
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To set the Game Options 

In the Options window, choose the Game Options tab 

 

Options Window 

1) Choose an economy. If you change the economy after you run one or more cycles, the results 
for all of the cycles are affected, even the quarters you have already run. If you change the 
economy, you will need to reprint and redistribute all reports from the period 2.2 on. 

2) Only Position 1 is currently available 

3) If you want to play in the competitive mode, select the Play in Competitive Mode option. 
When this option is selected, the competitive mode begins. Most instructors start the 
competition in period 2.4.  You can highlight this box and change the quarter to start the 
competitive mode. 

4) A new allow speculation option was added.  If this is not checked there is no student hedge 
decision.  SBG automatically hedges each bank.  If checked students have the option of 
adjusting the SBG calculation by a percentage. 

 Warning:  Once you have begun the competitive mode, you cannot return to the non-
competitive mode. 4`) 

To set the Print Options 

1) In the Options window, choose the Print Options tab. 



  

 Print Options Tab, Options Window 

 Note:  The Print Options apply to all of the games, not just the current one. If you want different Print Options 
for a game, change the options before printing.  

2) Set the following options by selecting the check boxes. The option is selected if an X 
appears in the box. 

 Print Date/Time on Reports  If this option is selected, the actual calendar date and time that the report is 

printed appear on the report. 

 Print Cover Sheet If this option is selected, a cover sheet with the text entered under the Course tab is 

printed with the report.  

3) Choose one of the following options by selecting the option button. 

 One Copy of Each Page If this option is selected, one copy of each page of the report is printed. 

One Copy for Each Player If this option is selected, one copy of the report is printed for each player – this 

creates a very large print job that can be too large for some network printer setups.. 

Change Printer  To change the printer or printer options, choose the Printer button. The Windows Printer 

dialog box appears.  
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ENTERING THE DECISIONS  
After you have set up a new game, the first quarter for enterable decisions is 2.2. Enter your 2.2 decisions , 

and then run the cycle and print the reports. Each quarter, you repeat the same process; enter the decisions, 

run the cycle, print the reports. 

 

Decisions Window 

The Decisions window displays the following information: 

Cycle The current period for the game. You can change the period by highlighting this and 

pressing the plus or minus keys. 

Game The name of the bank game you selected in the main window. 

Bank The number of the bank whose tab is selected. 

Decision 

Variables 

The decisions. The decision variables and their allowable values are discussed in the  

Players’ Manual.  If these are incorrect you can reset the game by running the prior cycle. 

Value The values for the decision variables. 

Remarks The allowable ranges of values where appropriate. 

The Decisions window has three command buttons: 

 

 

Revert to Saved Changes all the values to what they were before you last saved.  

For example, if you enter all of Bank 1 and part of Bank 2 and then choose Revert to Saved, 



all of the decisions that you entered for Bank 1 and Bank 2 are replaced with the previously 

saved values. If you enter all of Bank 1 and choose Save to Disk, then enter part of Bank 2 

and choose Revert to Saved, only the decisions that you entered for Bank 2 (since you last 

saved) are replaced with the previously saved values. 

Save to Disk Saves the values you have entered. 

Save and Return Saves the values you have entered and returns to the main window. 

To enter the decisions 

1) Start the Stanford Bank Game as explained earlier, if it is not already running. 

2) Select the game that you want to work on in the Stanford Bank Game main window. The 
window shows the game information and the current quarter. If you need to enter decisions for 
an earlier quarter, see the directions on Rerunning Previous Periods later in this manual.  

3) Choose the Enter Decisions button in the main window or from the Edit menu, choose 
Decisions. Wait until the Decisions window appears. 

4) Choose the tab for the bank whose decisions you want to enter. If there are more than five 
banks in the game, use the scroll bar to display the other bank tabs. 

5) Use the mouse or the TAB key to move the cursor to the Value column after the Decision 
Variable that you want to enter.  

6) Type the value in the box. The Remarks column indicates the allowable range of values where 
appropriate. For more information, see the description of the decision form in the Players’ 
Manual. 

7) Use the mouse, TAB key, or arrow keys to move the cursor to the next Value box and 
continue entering the values until the decision form is complete. All of the values do not 
appear on one screen; you will need to scroll down to enter all the values. 

Note:  TAB or ENTER moves the cursor to the next box in which you can enter data; 
SHIFT+TAB moves the cursor to the previous box. 

1) Choose the Bank 2 tab to open the next bank and enter the decisions for that bank. Continue 
with the other banks until all of the decisions are entered. Choose Save to Disk frequently to 
save your work. 

2) When you are finished, choose the Save and Return button to close the Decisions window and 
return to the main window. 

There are activities that can confuse the counters SBG uses to identify the correct set of economic data, If 
the limits on loan rates do not agree with the pre-coded and expected economic data for the quarter you may 
not be able to enter data.  This problem is corrected by rerunning the prior cycle as this resets the 
information. 

RUNNING THE NEXT CYCLE 
When you are satisfied with the decisions you have entered, you can run the next cycle of the game. 

To run the next cycle 

 In the main window, choose the Run A Cycle button, or from the Run menu, choose Cycle. 

When the cycle is completed, the Reports window appears. Print the reports as explained next or choose the 

Close button to return to the main window. Printing a full set of reports is a very large print job and 
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some networked printers may need to have the size of the cache file expanded. You can use the print  pdf 

file option as a work around. 

PRINTING THE REPORTS 
After you have run a cycle of the game, you can print the reports for that cycle. To print the reports for a 

previous quarter, you must first rerun that quarter. 

 

Reports Window 

The Reports window shows the number of copies that will be printed of each page for each bank. The 

default values appears when you open the window or when you choose the Reset button. The default values 

are determined by the numbers you entered in the Parameters window. For example, if you entered 5 

players for Bank 1 and selected the option “One Copy for Each Player,” a “5” appears after each page in the 

column under Bank 1. 

The Reports window displays the following information: 

Quarter The report period. 

Bank Number The bank number. 

Page Number The report page number. The cell created by the bank number and page number shows the 

number of pages that will be printed of that page for each bank.  NOTE you can disable 

single pages by clicking on that cell – page 1 & 2 for bank # 1 will not print in the above 

example.  If you click on “bank 1” it will change the setting for all the pages for bank 1.  If 

you click on “page 1” it will change all the settings for page 1. 

Print Instructor’s 

Reports 

Select this option if you want to print the Instructor’s Reports. 

Create Spread If checked you get a csv file for each bank.  The csv file (s)  will be identical to the regular 



sheets print report you have configured.  So if you decide to only print one page from one bank, the 

csv file will only contain that page of information. 

Total  The total number of pages that will be printed. 

To Go During the printing process, the number of pages remaining to be printed. 

The Reports window has four command buttons: 

Print Starts the printing. 

Reset Resets all the numbers to the default values. After the Reset button is selected, it changes to 

the Zero button. 

Zero Sets all the values to zero. After the Zero button is selected, it changes to the Reset button. 

Setup Opens the Windows Printer dialog box. 

Close Closes the Reports window without printing. 

To print the reports for the current quarter 

1) After you run a cycle, the Reports window appears.  

 If you want to change the Print Options before printing, choose the Close button to return 
to the main window. Then choose the Options button or, from the Edit menu, choose 
Options, and set the Print Options as explained earlier under Starting a New Game. 

 If you have closed the Reports window after running a cycle, return to main window. 
Then choose the Print Reports button or, from the Run menu, choose Reports. The Print 
Reports button and Run Reports command are dimmed each time you start the program 
until you run a cycle of the game.  

2) Set the number of reports you want to print, by doing any of the following: 

 To enter the default values, choose the Reset button or from the File menu, choose Reset. 
After the Reset button is selected, it changes to the Zero button. 

 To return to all zeros, select the Zero button, or from the File menu, choose Zero. After 
the Zero button is selected, it changes to the Reset button. 

 Click on the bank number to toggle a column between zero and one. 

 Click on the page number to toggle a row between zero and one. 

 Type a number in the appropriate row and column. 

The total number of pages to be printed appears at the bottom of the window under Total. 

1) If you want to print the Instructor’s Report for this period, select Print Instructor’s Report. An 
X appears in the box when the option is selected. 

2) If you need to change your printer setup, choose the Setup button or from the File menu, 
choose Printer Setup to open the Windows Printer dialog box.  

3) Choose the Print button or from the File menu, choose Print. As the reports print, the number 
under To Go changes accordingly. 

4) When the printing is complete, choose the Close button or from the File menu, choose Close 
to return to the main window. 
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THE REPORT 
The Stanford Bank Game report has two sections for participants:   

1) Information specific to their bank only 

2) Information Common to All Banks 

There are also Instructor’s Reports. You can use parts of the Instructor’s Report as additional handouts for 

the participants. However, the participants should not see the other banks’ decision information because it 

includes the officer time allocation, the only unknown variable in the game. 

RERUNNING AN EARLIER CYCLE 
You can rerun previous cycles of the game if necessary. There are three situations in which you may want to 

rerun a cycle. 

 Many instructors have their students submit a second set of decisions for the first quarter, 2.2, after they 

have studied the first set of reports. They then enter the decisions and rerun 2.2. 

 If you need to reprint the reports from an earlier quarter without changing any decisions, you must first 

rerun the quarter. As long as you do not change any decisions, the reports will be duplicates of the 

earlier reports.  

 If you want to change a decision from an earlier period, you need to return to that period, change the 

decisions, rerun the cycle, and print the reports. The changes affect every quarter from the changed 

quarter to the current quarter, whether you rerun the interim quarters or not. To produce reports for the 

interim quarters, run a quarter and print its report; then run the next quarter and print its report, and so 

on. 

To rerun a previous cycle 

1) In the Stanford Bank Game main window, change the period. You can type in the new period 
or press the minus or plus sign on your keyboard (-) until the quarter you want appears. 

2) If you want to change the decisions, enter the decisions as explained earlier. Remember that 
the changes affect every quarter from the changed quarter to the current quarter, whether you 
rerun the interim quarters or not. 

3) Choose the Run A Cycle button. When the game is complete, the Reports window appears. 
Print the reports as explained earlier or choose the Close button to return to the main window. 

 
MODEL SENSITIVITIES 

SHARE PRICE COMPONENTS 

Market price of individual bank stock is a function of— 
 

1) K-factor: P/E adjustment multiplier 

2) Current quarter’s industry P/E ratio 

3) Twenty percent of Weighted Adjusted non-operating earnings per share 

4) Weighted and smoothed operating earnings per share net of reductions to shareholder value 

5) Book value per share 

6) The previous quarter’s stock price (if you are in the competitive mode of the program) 



MINIMUM MARKET PRICE OF STOCK (Based on Book Value): 

          Total Equity X .041      X  Industry P/E Ratio 

Number of Shares Outstanding 

K-FACTOR 

K-factor is a function of— 
 
1) Capital Adequacy  

A capital adequacy ratio (total qualifying capital divided by total required capital) greater than 
1.3 has no further positive effect. A ratio below 1.0 has a negative effect. The neutral point is 
1.0. 

- - - - - - - - - / + + + + + + + + +/ 

                1.0                1.3   

 
2) Capital Notes  

Leverage (capital notes divided by total equity) below 17.5% has a positive effect until it 
reaches 7.5%. Above 17.5% there is a negative effect which accelerates above 22.5% and 
reaches a regulatory maximum at 30%; 17.5% is the neutral point. 

                                     - 

                                  - 

                               - 

                            - 

/ + + + + / - - - - - / -           / 

7.5%     17.5%       22.5%         30% 

 
3) Non-Accruing Loans  

The neutral point for non-accruing loans (as a percentage of total loans) is 1.75%. Levels 
above that will hurt stock price until 6.25%. 

/ + + + + + / - - - - -/ 

0         1.75       6.25% 

 
4) Growth in Assets  

A 3% quarterly growth rate in weighted total assets is a neutral position. This is a 12% 
annualized growth rate with no maximum or minimum limits. 

- - - - - - - - - / + + + + + + + + + 

                 12% per year          

 
5) Growth in Weighted Adjusted Operating Earnings Per Share  

A 3% quarterly (12% annual) growth rate in WEPS has a neutral effect. However, this factor 
is weighted very heavily for determining the overall K-factor. That is, earnings growth greater 
than this is rewarded substantially and growth less than this is punished substantially. 
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                                   + 

                              + 

                         + 

                     + 

                  /                      

                 12%      

             - 

          - 

       - 

    - 

 
6) Liquidity Effect 

Liquidity is calculated as follows: 

Cash - Required Reserves + Funds Sold + 90-day Gov.+Loans Maturing - CD’s Maturing 

                                                       Total Assets                     
A ratio greater than 25% has no additional effect; 15% is the neutral point. Below 15% there 
is a negative effect. 

/ - - - - - - - - / + + + + + + + + / 

0                15%               25% 

 
7) Business Development Expenditures  

When the weighted average quarterly amount spent on advertising is .05% of total assets, it 
has a neutral effect. There are no benefits for having a ratio higher than .09%. Therefore, for a 
bank with $1 billion in assets the business development budget should be between $500,000 
and $900,000 per quarter. 

- - - - - - - - - / + + + + + + + + / 

                .05%              .09% 

 
8) Fed (LIBOR) Funds Borrowed  

The neutral point for the ratio, Fed (LIBOR ) funds purchased divided by total assets, is 5%. 
Above that, there is a negative effect. Below that, to 2%, there is a positive effect.  There is no 
additional positive effect below 2%. 

/ + + + + + + + + / - - - - - - - -  

2%                5%                                  

 
9) Federal Reserve (Central) Bank Borrowing  

FRB (Central Bank) borrowing will have a substantial negative effect. This penalty reaches its 
maximum at 15% (borrowing divided by total assets) and remains at that level even if the ratio 
is increased. 

/ - - - - - - - - - / 

0                  15% 



 
10) Dividend Payout  

                      Dividend Per Share                        

25% of previous 4 quarters’ adjusted operating income 
You are penalized for a payout ratio anywhere below 25% and greater than 99%. You are 
slightly rewarded for payouts between 25% and 35%. Once your ratio gets as low as 5%, there 
are no further negative effects. 

no effect/ - - - - / + + + +  /no effect/ - - - 

        5%        25%        35%       99% 

11) Dividend Cut  
Once a team cuts its dividend, the model will remember it for the remainder of the game. 
Although the effects will diminish over time, stock price will suffer for at least 3 quarters. The 
extent of the penalty depends on the percentage cut in the dividend. There is no expressed 
reward for increasing the dividend. 

FACTORS WHICH AFFECT CAPITAL NOTE ISSUES 

1) The previous quarter’s capital adequacy ratio 
A ratio above 1.20 does nothing to lower the interest rate further. A ratio below 1.20 has a 
progressively negative effect on the interest rate (i.e., increases it). 

- - - - - - - - - - - - / (no effect) 

                       1.2           

2) The previous quarter’s debt ratio 
A debt ratio (debt/equity) greater than 21.2% has a progressively negative effect on the 
interest rate (i.e., increases it). A ratio below 21.2% has no effect. 

(no effect)      / - - - - - - - - - - - 

               21.2% 

3) Purchased funds available 
If relatively few purchased funds are available, the rate the bank has to pay on its new capital 
notes increases. If either Fed funds (LIBOR funds) or CD’s available as a percentage of assets 
are less than 10% and 35% respectively, this increases the interest rate. 

If the approximate rate for capital notes from the previous quarter is different from the actual, 
there are two reasons: 

1) The capital adequacy effect is squared for the actual, but not for the approximate. 

2) The approximate rate assumes that the bank will issue $5 million in new notes. If the bank 
issues more than this, the actual rate will increase, and if the bank issues less than $5 
million, the actual rate will decrease (everything else being equal). 
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FACTORS WHICH AFFECT THE INTEREST RATES OF NEW CDs  

1) The Government Bond Rates   
For instruments with similar maturities, each bank’s CD rates will float approximately 25-75 
basis points above these rates. Premiums above this are attributable to any combination of the 
following factors. 

2) The Capital Adequacy Ratio 
The higher the capital adequacy ratio is above 1.0125, the less the bank pays for CD’s. 
Likewise, the lower the capital adequacy ratio is below .9875, the more the bank pays for 
CD’s. A capital adequacy ratio above 1.175 has no further effect on the interest rate for new 
CD’s. 

- - -/         /+ + + + + + + +/ no further effect 

   .9875   1.0125            1.175%                                

3) ROE 
The lower a bank’s ROE in the previous quarter, the higher their CD rates. ROE’s greater than 
10% have no penalties. Below this, penalties get steeper as ROE’s decrease to negatives. 

ROE - - - / - - - / - - - / 

   0%         5%         10%     

4) Officer Time 

5) Supply of Funds in the Economy 

FACTORS WHICH AFFECT TEMPORARY EMPLOYEES & OTHER 

EXPENSES 

1) Credit card processing costs. 

2) Direct expenses associated with loan commitments (.02% to .03% of total commitments). 

3) Total deposits and demand deposit processing costs. 

4) Economic activity which affects total loans and deposits available in the market. 

5) Salaries and benefits (approximately 5%). Also, if salaries decrease by more than 5% in any 
given quarter, this increases expenses even more. 

6) Security sales ($4,000 for each sale). 

7) Capital flags for either notes or equity ($110,000 for each flag). 

8) Officer time devoted to new business. Once this exceeds approximately 50%, the expenses 
increase exponentially. 

9) Salary policy and the previous quarter’s ROE. Basically, if the bank has good or even just 
respectable earnings, expenses will increase if salary policy doesn’t properly compensate 
employees. 

10) Credit policy. The more conservative the credit policy, the more expensive it is to the bank. 
The cost of this additional scrutiny is reflected here. 



THE SALARY CALCULATION 

The salary expense each quarter is based on the size and types of assets and liabilities in the bank. To 

calculate salary expense, the computer model first divides the accounts into categories. 

Category I: Securities and Fed (LIBOR) Funds Purchased/sold; 

Category II: Prime & Syndicated Loans, Commercial Demand Deposits, Due to Banks, CD’s, 
and FRB (Central Bank) Borrowing; 

Category III: High Loans, Public (State) Time Deposits, Public (State) Demand Deposits, and 
Money Market Time Deposits; 

Category IV: Medium Loans, Real Estate, Consumer, and Credit Card Loans, and Regular 
Demand Deposits; 

Category V: Net Premises 

The computer program adds the ending balances of the accounts in each category and multiplies by a 

factor in order to obtain the quarterly salary expense. 

Quarterly Salary = .00063 (I) + .00125 (II) + .002 (III) + .00313 (IV) + .0625 (V) 

If participants complete calculation, the number will be slightly different from the figure in their report, 

because SBG is smoothing the changes that occur in the account balances over several quarters. 
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Appendix A 

TERMINOLOGY 

SBG VERSION XII, INTERNATIONAL & U.S. EDITIONS 

The simulation program models are identical and the only differences are in the terms used in the reports 

and Players’ Manuals.  Equivalent terminology is as follows: 

 

U.S. Edition International Edition 

1)  Federal Funds 1)  LIBOR Funds 

2)  (U.S.)Treasury Bills 2)  90 Day Government Securities 

3)  Trust Fees and Income 3)  Pension Fees and Income 

4)  U.S. Government Notes 4)  (Other) Government Securities 

5)  Federal Reserve Bank 5)  Central Bank 

6)  Public Demand Deposits 6)  State Demand Deposits 

7)  Trust Department Deposit Accounts 7)  Pension Department Deposit Accounts 

8)  Municipal Bonds 8)  State Bonds 

9)  U.S. Treasury Tax and Loan Accounts 9)  Government Tax and Loan Accounts 

10)  Public Time Deposits 10)  State Time Deposits 

11)  Municipal Securities 11)  State Securities 

12)  Rediscount Rate 12)  Central Bank Rate 



Appendix B 

STOCK PRICING FACTORS and  

FINANCIAL STATEMENT ANALYSIS  

STOCK PRICING FACTORS 

In SBGs idealized market, a bank’s stock price represents what investors are willing to pay for each share of 

common stock. The primary determinants of the stock price are the bank’s Adjusted Operating EPS 

(exponentially smoothed), the average P/E ratio of all banks in the economy, and the K factor. The K factor 

may be less than or greater than 1.0, meaning that an individual bank’s stock is selling for a discount or a 

premium relative to the average P/E ratio.  

SBG includes a simplified hedging feature. In order to keep the hedging feature simple, we had to bend 

a few accounting rules. For the purpose of calculating stock price, we calculate the difference between non-

operating earnings and the after tax adjustment to retained earnings.  

If the number is negative, operating earnings are reduced by this amount. All calculations in the 

Stanford Game that would normally use “earnings” (for example, ROE) use this adjusted operating earnings 

figure. If the number is positive, 20% of the average value over the last two quarters is used as a positive 

addition to stock price. Basically, the model rewards sustainable increases to shareholder value and 

penalizes decreases. Changes in equity also have a direct effect on the capital ratio, which is an important 

variable in the cost of funds for each bank. 

The stock price of a particular bank is determined by taking the product of its exponentially smoothed 

earnings (which include the adjustments noted above), the economy average P/E ratio, and the bank’s K 

factor. Stock price is weighted over several quarters of time and previous stock prices affect the current 

price. Some of the measures in the stock price equation are in no way intended to be an exact replication of 

real market behavior. Rather, they are to some extent replacements for regulatory constraints. For detailed 

information on stock price and the K factor, see “Model Sensitivities.”  
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FINANCIAL STATEMENT ANALYSIS 

 

Ratio Formula 

Performance Ratios 
 

Return on Equity (ROE) (Net income x 4) ÷ Total equity 

Return on Assets (ROA) (Net income x 4) ÷ Total resources 

Equity Multiplier (EM) Total resources ÷ total equity 

Profit Margin (PM) Net income ÷ gross operating income 

Asset Utilization (AU) Gross operating income x 4 ÷ total resources 

Net Interest Margin (NIM) (Total interest income - Total interest paid) ÷ (Federal funds sold + 

Total securities + Gross loans and mortgages - Provision for loan 

losses from the Balance Sheet) 

Earnings Base (EB) (Federal funds sold + Total securities + Gross loans and mortgages - 

Provision for loan losses) ÷ Total resources 

Spread [Total interest income ÷ (Federal funds sold + Total securities + Net 

loans and mortgages)] - [Total interest paid ÷ (Time deposits + 

Federal funds purchased + Funds borrowed from FRB)] 

Burden/Total assets [(Service charge income + Fees and other income) - (Salaries and 

benefits + Occupancy expense + Business development + Other 

expenses x 4)] ÷ Total resources 

Noninterest income/Overhead 

Expense 

(Service charge income + Fees and other income) ÷ (Salaries and 

benefits + Occupancy expense + Business development + Other 

expense) 

Expense Control:  

PM Components 

 

Interest expense/Total revenue Total interest paid ÷ Gross operating income 

Average interest cost of 

liabilities: 

 

Public funds (Public interest expense x 4) ÷ Public time deposit accounts 

Certificates of deposit (CD's interest expense x 4) ÷ CD's time deposit accounts 

Savings deposits (Savings interest expense x 4) ÷ Public time deposit accounts 

Federal funds purchased (Fed fund purchases interest expense x 4) ÷ Federal funds purchased 

FRB borrowing (FRB borrowing interest expense x 4) ÷ Funds borrowed from the 

FRB 



Capital notes (Capital notes interest x 4) ÷ Capital notes 

Liabilities  

(Percent of Total Assets) 

 

Demand deposit accounts: Demand deposits ÷ total resources 

Commercial (Commercial demand deposits + Due-to-banks Demand deposits) ÷ 

Total resources 

Consumer Regular checking demand deposits ÷ Total resources 

Public funds Public demand deposits ÷ Total resources 

Time deposit accounts: Time deposits ÷ Total resources {BS} 

Money market savings Money market savings ÷ Total resources 

Certificates of deposit Certificates of deposit (private) ÷ Total resources 

Public funds Public time deposit accounts ÷ Total resources 

Federal funds purchased Federal funds purchased ÷ Total resources 

FRB borrowing Funds borrowed from FRB ÷ Total resources 

Capital notes Capital notes ÷ Total resources 

Other borrowed funds Other liabilities ÷ Total resources 

Interest-bearing liabilities (Time deposits + Federal funds purchased + Funds borrowed from 

FRB) ÷ Total resources  

Stockholders' equity Total equity ÷ Total resources 

Overhead Expenses  

(Percent of Total Revenue) 

 

Personnel expense Salaries and benefits ÷ Gross operating income 

Occupancy expense Occupancy expense ÷ Gross operating income 

Business development expense Business development expense ÷ Gross operating income 

Other operating expenses Other expenses ÷ Gross operating income 

Total operating expenses (Salaries and benefits + Occupancy expense + Business development 

expense + Other expenses) ÷ Gross operating income 

Current Loan Loss 

Provision/Total Revenue 

Addition to the loan loss provision for: (Syndicated loans + Prime 

loans + High loans + Medium loans + Real estate loans + Consumer 

loans + Credit card loans) ÷ Gross operating income 

Income Taxes/Total 

Revenue 

Applicable taxes ÷ Gross operating income 

Extraordinary Gains/Total 

Revenue 

Gains on securities and loans (after tax) ÷ Gross operating income 
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Gross Income:  

AU Components 

 

Interest income/Total assets (Total interest income x 4) ÷ Total resources 

Gross yields on assets:  

Syndicated loans (Syndicated loan interest x 4) ÷ Beginning syndicated loan balance 

Prime commercial loans (Prime loan interest x 4) ÷ Beginning prime loan balance 

High grade commercial loans (High loan interest x 4) ÷ Beginning high loan balance  

Medium grade commercial 

loans 

(Medium loan interest x 4) ÷ Beginning medium loan balance  

Real estate loans (Real estate loan interest x 4) ÷ Beginning real estate loan balance  

Consumer loans (Consumer loan interest x 4) ÷ Beginning consumer loan balance 

Credit card receivables (Credit card loan interest x 4) ÷ Beginning credit card loan balance  

Federal funds sold (Fed funds sales interest x 4) ÷ Federal funds sold  

Treasury bills (Treasury bills interest x 4) ÷ Treasury bills  

U.S. Government notes (U.S. Government notes interest x 4) ÷ U.S. Government notes  

State and municipal securities (State and municipal bonds interest x 4) ÷ State and municipal 

securities 

Assets  

(Percent of Total Assets) 

 

Gross loans and mortgages: Gross loans and mortgages ÷ Total resources  

Syndicated loans Ending syndicated loan balance ÷ Total resources 

Prime commercial loans Ending prime loan balance ÷ Total resources  

High grade commercial loans Ending high loan balance ÷ Total resources  

Medium grade commercial 

loans 

Ending medium loan balance ÷ Total resources 

Real estate loans Ending real estate loan balance ÷ Total resources 

Consumer loans Ending consumer loan balance ÷ Total resources 

Credit card receivables Ending credit card loan balance ÷ Total resources 

Loan loss reserve Provision for loan losses ÷ Total resources 

Total investment securities: Total securities ÷ Total resources 

Treasury bills Treasury bills ÷ Total resources 

U.S. Government notes U.S. Government notes ÷ Total resources 

State and municipal securities State and municipal securities ÷ Total resources 



Cash and due from banks Cash and due from banks ÷ Total resources 

Bank premises Bank premises (net of depreciation) ÷ Total resources  

Other assets Other assets ÷ Total resources 

Noninterest Income 

(Percent of Total Assets) 

 

Total noninterest income: [(Service charge income + Fees and other income) x 4] ÷ Total 

resources 

Service charge income (Service charge income x 4) ÷ Total resources 

Trust income (Trust fees x 4) ÷ Total resources 

Real estate income [(Real estate servicing income + Real estate loan initiation fees) x 4] 

÷ Total Resources  

Credit card income (Credit card fees x 4) ÷ Total resources {BS & #18} 

Commercial loan fee income [(Financial services fees + Letter of credit fees + Loan commitment 

fees) x 4] ÷ Total resources  

Other fee income (Other fee income x 4) ÷ Total resources 

Credit Risk Ratios 
 

Net loan charge-offs/Gross loans 

and mortgages 

[(Charge-offs for: Syndicated Loans + Prime loans + High loans + 

Medium loans + Real estate loans + Consumer loans + Credit cards) 

x 4] ÷ Gross loans and mortgages 

Loan loss reserves/Gross loans 

and mortgages 

Provision for loan losses ÷ Gross loans and mortgages 

Loan loss reserves/Nonaccrual 

loans 

Provision for loan losses ÷ (Nonaccruing loans in: Prime loans + 

High loans + Medium loans + Real estate loans +Consumer loans + 

Credit cards) } 

Current provision for loan 

losses/Gross loans and 

mortgages 

[(Addition to the loan loss provision for: Syndicated loans + Prime 

loans + High loans + Medium loans + Real estate loans + Consumer 

loans + Credit cards) x 4] ÷ Gross loans and mortgages 

Loans refused/Gross loans and 

mortgages 

[(Loans refused in: Prime loans + High loans + Medium loans + Real 

estate loans + Consumer loans + Credit cards) x 4] ÷ Gross loans and 

mortgages 

Annualized growth in gross 

loans and mortgages 

Quarterly percentage change in gross loans and mortgages x 4 

Annualized growth in provision 

for loan losses 

Quarterly percentage change in provision for loan losses x 4 

Liquidity Risk Ratios 
 

Total equity/Total assets Total equity ÷ Total resources 
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Core deposits/Total assets [(Total demand deposits x 0.6) + Money market savings + Public 

time deposit accounts] ÷ Total resources 

Volatile liabilities/Total assets 10% of Demand Deposits + CD’s maturing in 90 days + F. Funds 

Purchased + FRB Borrowing ÷ Total resources  

Liquid Assets/Total Assets Cash and Due From + F. Funds sold + Govt. Securities ÷ Total 

Assets 

Net Volatile Assets/Total Assets Total Securities – total pledge ( if positive number) + Due from 

Banks + FF sold ÷ Total resources  

Securities maturing within one 

year/Total assets 

[U.S. Government securities maturing in: (1 to 90 days + 91 to 180 

days + 181 to 270 days + 271 to 365 days) + State and muni 

securities maturing in: (1 to 90 days + 91 to 180 days + 181 to 270 

days + 271 to 365 days)] ÷ Total resources 

Net loans and mortgages/Total 

assets 

(Gross loans and mortgages - Provision for loan losses) ÷ Total 

resources 

Net loans and mortgages/Total 

deposits 

(Gross loans and mortgages - Provision for loan losses) ÷ Total 

deposits 

Interest Rate Risk 
 

Repriceable assets/Total assets:  

Within three months Total rate sensitive assets maturing in 1 to 90 days ÷ Total resources  

Within one year [Total rate sensitive assets maturing in: (1 to 90 days + 91 to 180 

days + 181 to 270 days + 271 to 365 days)] ÷ Total resources 

Repriceable liabilities/Total 

assets: 

 

Within three months Total rate sensitive liabilities maturing in 1 to 90 days ÷ Total 

resources  

Within one year [Total rate sensitive liabilities maturing in: (1 to 90 days + 91 to 180 

days + 181 to 270 days + 271 to 365 days)] ÷ Total resources 

Repriceable gap/Total assets:  

Within three months Balance sheet gap in 1 to 90 days ÷ Total resources 

Within one year [Balance sheet gap in: (1 to 90 days + 91 to 180 days + 181 to 270 

days + 271 to 365 days)] ÷ Total resources 

Capital Risk 
 

Total equity/Total assets Total equity ÷ Total resources 

Total qualifying capital/Total 

assets 

Total qualifying capital ÷ Total resources 

Capital notes/Total assets Capital notes ÷ Total resources  



Cash dividends/Net income Dividend declared ÷ Net income 

Annualized growth in total 

equity 

Quarterly percentage change in total equity x 4 

Annualized growth in total 

qualifying capital 

Quarterly percentage change in total qualifying capital x 4 

Operational Risk 
 

Personnel expense/Total assets (Salaries and benefits x 4) ÷ Total resources 

Occupancy expense/Total assets (Occupancy expense x 4) ÷ Total resources 

Business development 

expense/Total assets 

(Business development expense x 4) ÷ Total resources } 

Total assets/Number of branches Total resources ÷ Current number of branches 

Total deposits/Number of 

branches 

Total deposits ÷ Current number of branches 

Total loans/Number of branches (Gross loans and mortgages - provision for loan losses) ÷ Number of 

branches 
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DEFINITIONS FOR DERIVED VARIABLES 
 

Ratio Formula 

1. Net interest income Total interest income - Total interest paid 

2. Earning assets Federal funds sold + Total securities + Gross loans and mortgages - 

Provision for loan losses 

3. Net interest margin Net interest income ÷ Earning assets 

4. Earnings base Earning assets ÷ Total assets 

5. Interest-bearing liabilities Time deposits + Federal funds purchased + Funds borrowed from 

FRB 

6. Spread (Total interest income ÷ Earning assets) - (Total interest paid ÷ 

Interest bearing liabilities) 

7. Burden Noninterest income - Noninterest expense 

8. Noninterest income Service charge income + Fees and other income 

9. Noninterest expense 

(overhead) 

Salaries and benefits + Occupancy expense + Business development 

expense + Other expenses 

10. Core deposits (Demand deposits x 0.6) + Money market savings + Public time 

deposits 

11. Volatile liabilities (Demand deposits x 0.4) + CD's (private) 

12. Total qualifying capital [Total equity + Capital notes + (Loan loss reserves x 0.5)] 

   

 Net loans and mortgages Gross loans and mortgages - Provision for loan losses 
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MAXIMUM AND MINIMUM RATES  
The annual interest rates on the decision forms are compared to the annual rates in the economic 

information. In any given quarter: 

 

ASSET OR LIABILITY MAXIMUM RATE 

ABOVE MARKET 

MINIMUM RATE 

BELOW MARKET 

 IN BASIS POINTS 

Prime Loans 20 150 

High Loans 30 150 

Medium Loans 40 150 

Real Estate Loans 300 250 

Consumer Loans 300 250 

Money Market Savings 150 150 

 

 


